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Taskstream FAQs  

Click the links in each question or description to navigate to the answer: 

System Requirements FAQs 

 What Internet browsers can I use to access Taskstream? 

 Can I use Taskstream on a Mac or a PC? on a desktop or laptop computer? 

 Does Taskstream work on iPad, iPhone or Android-based devices? 

 Do I need additional plugins or add-ons to use Taskstream? 

 Can I access Taskstream offline? 

 Does Taskstream require JavaScript to be enabled? 

 Does Taskstream require cookies to be enabled? 

 Does Taskstream use pop-ups?  

 How can I import and export data within Taskstream? 

Technical FAQs 

 Can I have Taskstream open in more than one window at a time? 

 Is Taskstream's site accessible to users with disabilities? 

 What is a Comma Separated Value (CSV) file? 

 How do I print my work? 

 How do I format my text? 

 How do I add special characters, such as math symbols or special punctuation, to my text? 

 What is WebMarker File Markup? 

 What is Turnitin® Originality Reporting? 

 Can I change the size of the Taskstream text/fonts? 

Troubleshooting 

 When I click on a button nothing occurs. 

 Some of the features within the Taskstream site are missing. 

 When I try to download/view a file attachment, nothing happens. 

 I am not receiving emails from Taskstream. 

 I uploaded a file on my Mac, but the attached file does not open.   

 My file is too large to upload. 

 Taskstream is reporting that I have entered unsafe text. What HTML formatting is "whitelisted" for 

safe use? 

 My Taskstream graphs are empty. 
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System Requirements FAQs 

Which Internet browsers can I use to access Taskstream? 

Your Internet browser (such as Internet Explorer or Firefox) is a computer application that allows you to access and 

view various web sites on the Internet. Taskstream is a highly dynamic environment that responds slightly 
differently to each browser.  

We recommend using a supported browser to get full Taskstream capability: 

Windows 

 Microsoft Internet Explorer 7.0 and above 

 Mozilla Firefox 3.5 and above 

 Google Chrome 4.0 and above 

Mac 

 Mozilla Firefox 3.6 and above 

 Apple Safari 4.0 

 Chrome 5.0 

If you use a browser other than those listed above, you may still be able to access Taskstream but you may not 

have access to all the system's features. 

Regardless of the browser, you will need to have pop-ups , cookies and JavaScript enabled in order to use all 
the features of Taskstream.  

 If you are unable to log in AT ALL, you may be using a browser with known issues. Please install one of the 
supported browsers and use this to access Taskstream. 

How can I tell which Internet browser version I have? 

Version information is available from an "About" option in one of the browser's menus.  

Internet Explorer (IE) 

To find out which version of Microsoft Internet Explorer (IE) is installed on your PC: 

1. Open Internet Explorer. 

2. Click Help on the tool bar 
OR,  
for newer versions of IE, click the gear icon: 

 

 

In newer versions of IE, a set of icons is displayed in the upper right corner of 
the window. The gear appears below the "X" that closes the window. 

The keyboard shortcut ALT+H will also open this menu. 

3. Click About Internet Explorer.  The window opens to indicate the current in-use version of 
Internet Explorer. 
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Mozilla Firefox 

To find out which version of Mozilla Firefox is installed on your PC or Mac: 

1. Open Firefox. 

2. Click Help on the tool bar. 

3. Click About Mozilla Firefox.  A window opens to indicate the current in-use version of Firefox. 

Google Chrome 

To find out which version of Google Chrome is installed on your PC or Mac: 

1. Open Chrome. 

2. Click Customize and Control Google Chrome on the tool bar. 

3. Click About Google Chrome.  A window opens to indicate the current in-use version of Chrome. 

Apple Safari 

To find out which version of Apple Safari is installed:   

1. Open Safari. 

2. Click Safari on the menu bar. 

3. Click About Safari. A window opens to indicate the current in-use version of Safari. 

 

Can I use Taskstream on a Mac or a PC? On a desktop or laptop 
computer? 

Yes, Taskstream works equally well on a Mac or PC and on both desktops and laptops. Whether you're using Mac or 
PC, you can run Taskstream from your choice of Internet browsers. 

Many Taskstream features are also available from mobile devices using built-in Internet browsers. 

 

Does Taskstream work on iPhones, iPads or other mobile devices? 

Though many Taskstream features work well on these devices using the built in browsers such as Safari and 
Chrome, full support on these mobile devices and tablets is not available yet. For example, the ability to upload file 
attachments is not supported because mobile and tablet devices do not support local file storage. Nevertheless, 
Taskstream is actively working to enhance the use of our site on these devices and will post regular updates as 
more features become available. 

 

Do I need additional plugins or add-ons to use Taskstream? 

No, you do not require additional plugins or add-ons. However, your Internet browser must have JavaScript and 
cookies enabled in order to log into the Taskstream site. On most browsers, these are default settings. 

 

Can I access Taskstream offline? 

You must have an internet connection to edit your work in Taskstream and to perform real-time tasks. 

You can, however, view your work offline by using Taskstream's Pack-It-Up feature (described in the Resources 
section of the online LAT Help) to make copies of your work and download them to your computer. Begin by 
"packing up" selected web pages and rubrics that you created in Taskstream. Your package is converted into html 
format that can be opened and read outside Taskstream, and then it is zipped (compressed) for downloading to 
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your computer. Once offline, you can save the package to your computer or to an external storage device such as a 
sufficiently large USB flash drive (aka "thumb drive" or "USB key") or, if your computer is equipped with this 
capability, burn it to a DVD or CD-Rom. 

 Pack-It-Up is designed for VIEWING work ONLY. It is not possible to import the downloaded work back into 
Taskstream, nor can you edit work on your computer with the Taskstream tool once it is downloaded. 

 

Does Taskstream require JavaScript to be enabled? 

Taskstream uses JavaScript to enhance the interaction and function of our site.  Your Internet browser comes with 
JavaScript capability, which is usually enabled by default.  

Upon logging in, if you have received a message that you require JavaScript, it means that your Internet browser's 
JavaScript feature has been disabled.  You must manually enable this feature and restart your browser.  Please 
follow the onscreen directions for your Internet browser to enable JavaScript. 

This issue can also be caused by certain security software. You should disable or adjust your preferences on your 
computer while working in Taskstream. 

Note: Google Chrome has JavaScript enabled by default, and does not currently support in-browser functionality to 
disable it. If you are receiving this message in Chrome, please check your security software. 

 

Does Taskstream require cookies to be enabled? 

Yes, Taskstream requires cookies to be enabled. The steps to enable cookies vary based on the specific version of 
the Internet browser you use. 

For help determining which browser version you use, click here. 

Internet Explorer (IE) 

Internet Explorer 7+ 

Starting from a session of Internet Explorer: 

1. Click Tools in the IE menu bar 

2. Select Internet Options 

3. Select the Privacy tab. 

4. Click Advanced. 

5. In the "Cookies" section of the Advanced Privacy Settings window, select "Override automatic cookie 
handling". 

6. Under "First-party Cookies", select the "Accept" or "Prompt" option. 

7.  In the Internet Options window, click OK to exit. 

Internet Explorer 6x 

Starting from a session of Internet Explorer: 

1. Click Tools in the IE menu bar. 

2. Select Internet Options. 

3. Select the Privacy tab. 

4. Click Advanced. 

5. Select "Override Automatic Cookie Handling." 
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6. Under "First-party Cookies", select the "Accept" or "Prompt" option. 

7.  In the Internet Options window, click OK to exit. 

Mozilla Firefox 

Mozilla Firefox 3+ for Windows 

Starting from a session of Firefox: 

1. Click Tools > Options  

OR (in later versions) go to the Firefox drop-down menu and select Options>Options. 

2. Click Privacy in the top panel. 

3. Set "Firefox will:" for Use custom settings for history. 

4. Check the box next to "Accept cookies from sites" to enable cookies. 

5. Click OK. 

Mozilla Firefox for Mac 

Starting from a session of Firefox: 

1. Go to the Firefox drop-down menu  

2. Select Preferences 

3. Click Privacy. 

4. Set "Firefox will:" for Use custom settings for history 

5. Check the box next to "Accept cookies from sites". 

Mozilla Firefox 2x for Mac 

Starting from a session of Firefox: 

1. Click Tools > Options  

2. Click Privacy in the top panel. 

3. Select the checkbox labeled "Accept cookies from sites". 

Google Chrome 

Chrome for Windows or Mac 

Starting from a session of Chrome: 

1. Select Chrome Tools (wrench icon) 

2. On the menu bar: 
For Windows, select Options; 
OR, for Mac, select Preferences.  

3. Click Under the Hood. 

4. Click Content settings in the "Privacy" section. 

5. Select Allow local data to be set to allow both first-party and third-party cookies.  

 If you only want to accept first-party cookies, check the box next to "Block all third-party 
cookies without exception." 

Apple Safari 

Safari for Mac 

Starting from a session of Safari: 

1. Go to the Safari drop-down menu. 

2. Select Preferences. 
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3. Click Security in the top panel. 

4. Under "Accept Cookies" select Only from sites you navigate to. 

Safari 5.x for Windows 

Starting from a session of Safari: 

1. Select Safari Tools (gear icon) > Preferences on the menu bar. 

2. Click Security in the top panel. 

3. Under "Accept Cookies" select Only from sites you navigate to. 

 Internet browsers are updated with ever-increasing frequency. If you update your browser to version that is 

higher than those listed here and these steps no longer apply, we recommend you do a web search for "enable 
cookies nameofbrowser version#" (for example, "enable cookies IE 9") to access the most recent information 
provided by the team that supports your browser. 

Does Taskstream use pop-ups?  

Yes, Taskstream uses pop-up windows in order to deliver our tools in the most efficient manner possible.  Luckily, 
in most Internet browsers Taskstream can be added as an accepted site.  This allows Taskstream’s pop-up windows 
to appear as you browse http://www.taskstream.com.   

Please keep in mind that your pop-up blocking software can be installed on your computer as a separate piece of 

software or as part of a security software package. 

The steps to enable pop-ups vary based on the browser you use.  

Internet Explorer (IE) 

Starting from a session of Internet Explorer: 

1. Click Tools in the IE menu bar 

2. Select Pop-up Blocker > Pop-up Blocker Settings 

3. Enter *.taskstream.com in the Address of website to allow text box, and click the Add button 

Mozilla Firefox 

Starting from a session of Firefox: 

1. Go to Tools on the Mozilla Foxfire toolbar and click on Options 
 OR, (in later versions) go to the Firefox drop-down menu and select Options >Options. 

2. Click Content. 

If you want to enable pop-up for ALL sites, 

a. Click to uncheck Block pop-up windows 

If you want to enable pop-up for Taskstream ONLY, 

a. Leave Block pop-up windows checked. 

b. Click on the Exceptions button. 

c. Enter *.taskstream in the address field and click the Allow button 

d. Click Close 

3. Click the OK button at the bottom of the page. 

http://www.taskstream.com/
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Google Chrome 

There are two options for enabling Taskstream pop-ups in Chrome. 

Option A: To enable only Taskstream pop-ups 

1. With a session of Taskstream running in Chrome, click the pop-up blocker button on the Google toolbar 

2. The current webpage will re-load and the pop-up blocker button should say "Site pop-ups allowed" 

Option B: 

Starting from a session of Chrome, select Chrome Tools (wrench icon) on the browser toolbar 

1. On the menu bar: 

For Windows, select Options 
For Mac or Linux, select Preferences. 

2. Click Under the Hood. 

3. Click Content settings in the "Privacy" section. 

4. In the "Pop-ups" section: 

If you want to enable pop-up for ALL sites, 

a. Select Allow all sites to show pop-ups. 

If you want to enable pop-up for Taskstream ONLY, 

a. Select Do not allow any site to show pop-ups. 

b. Click the Manage Exceptions button. 

c. Add *.taskstream.com as an exception 

 Internet browsers are updated with ever-increasing frequency. If you update your browser to version that is 
higher than those listed here and these steps no longer apply, we recommend you do a web search for "enable 
pop-ups nameofbrowser version#" (for example, "enable pop-ups IE 9") to access the most recent information 
provided by the team that supports your browser 

 

How can I import and export data within Taskstream? 

There are a number of ways that data can be imported or exported within Taskstream: 

 All Taskstream reports can be exported to Excel. 

For details, please refer to the specific Help topic related to the report you want to export 

 Evaluation data can be exported in bulk using an integration service called: TS Export. This is a bulk data 
export that produces XML data, along with associated data schema. 

For more information on this service, please contact the Mentoring Services department at Taskstream 
at 1-800-311-5656 

 Data can be imported via Comma Separated Value (CSV) file for a variety of purposes. See "What is a 
CSV file?" on page 2 for more information on using CSV files for importing data. 

 

mailto:help@taskstream.com
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Technical FAQs 

Can I have Taskstream open in more than one window? 

At times, subscribers want to have Taskstream simultaneously open in two (2) distinct windows. If you feel you 

have the need to do this (for example, to copy work from one window to another), please note the following: 

 Subscribers can only be logged into to their account once at any given time. If you try to log into your 

account a second time -- even if you are using two different browsers -- you will be prompted to terminate 
your first session. 

 Different subscribers cannot be logged into the same browser on the same computer at the same time.  

However, 

 Different subscribers can be logged into different browsers (e.g., Internet Explorer and Firefox) on the same 

computer. 

To have Taskstream running in two windows 

1. Log in as you normally do. 
2. Click the browser icon of a DIFFERENT browser than the one through which you are currently logged in. 

This opens an active window with that browser. 

Do not use File > New or Ctrl N to open the second window - this is not allowed by the system 

3. Using that second browser window, log in again with a DIFFERENT account than is logged into the first 
browser.  This provides you with two (2) distinct work sessions. 

If you have any questions, please contact the Mentoring Services department at Taskstream at 1-800-

311-5656 

  

Is Taskstream's site accessible to users with disabilities? 

Taskstream is committed to making its tools accessible for all users, including people with disabilities.  Our tools 
comply with Federal Section 508 guidelines and W3C WCAG recommendations as described in our accessibility 
statement. 

Some optional services and third-party plug ins may not be covered by this document.  As new technologies 
emerge, Taskstream strives to amend its tools to be compliant with the widest audience possible; however, for 
legacy reasons, some pages cannot be updated immediately. 

In addition to making technical changes to our websites to provide greater accessibility, we test them using 
multiple assistance-type technologies - such as screen readers and screen enlarging software - to analyze and 
modify our pages.  We also engage accessibility experts and people with disabilities to further test and modify our 
websites for optimal usability. 

  

mailto:help@taskstream.com
https://www.taskstream.com/pub/VPAT.asp
https://www.taskstream.com/pub/VPAT.asp
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What is a CSV file? 

A Comma Separated Value (CSV) file is a computer data file used for the digital storage of data structured in a lists 
form, where each associated item (member) in a group is separated by commas. 

Each line in the CSV file corresponds to a row in the table. Within a line, fields are separated by commas, each field 
belonging to one table column. CSV files are often used for moving tabular data between two different computer 
programs, for example between a database program and a spreadsheet program. 

For example: 

 
Year Maker Model Comments Price 

1997 Ford E350 
ac, abs, moon 3000.00 

1999 Chevy Venture "Extended Edition"   4900.00 

1996 
Jeep Grand Cherokee 

MUST SELL! 

air, moon roof, loaded 

4799.00 

The above table of data can be represented in CSV format as follows: 

1997,Ford,E350,"ac, abs, moon",3000.00 

1999,Chevy Venture,"Extended Edition","",4900.00 

1996,Jeep,Grand Cherokee,"MUST SELL!air, moon roof, loaded",4799.00 

Note that under certain conditions the CSV format uses double quotation marks to protect the contents 
of a field: 

 If a cell within the Excel spreadsheet contains a comma or other internal punctuation, the cell 
contents will be enclosed in double quotation marks. For example, notice the Comments field of 
the last row of data above: "MUST SELL!air, moon roof,loaded" 

 When a field in the spreadsheet is empty (as with the Comments field in the second row of the 
table above), a pair of double quotation marks serves as a placeholder for that empty field. 

Taskstream uses CSV files to handle bulk import of field placement data, test and GPA scores, external recipients, 
and course and program information (TSDE). 

Saving in CSV format 

Data saved in an Excel spreadsheet can easily be saved as a CSV file. 

1. In the File menu, select the Save As option. 

2. Enter a name for the file. 

3. Select CSV as the file format. 

4. Click Save. 

5. (Optional) If the system prompts that some features are not supported, click Yes. CSV files are plain text 
and do not preserve some capabilities of Excel, such as bold and font sizes 

 To view the CSV in its comma separated form, open in Notepad or any other plain text editor 
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 How do I print my work? 

Generally, to print a page in Taskstream use either the print button or icon located within that page, or the print 
feature of your browser. 

However, sometimes a single Taskstream window is divided into multiple frames that might print separately. For 
example, when you have a screen that displays a scrolling left panel, that panel and the main work space are two 
separate frames.  

To print a particular frame of a Taskstream window, use these options: 

Method 1- 

1. Click anywhere in the frame that has the information you want to print. This selects that frame. 

2. On your menu bar, click File. 

3. Select Print. 

Method 2 - 

1. Click anywhere in the frame that has the information you want to print. This selects that frame. 

2. On your browser's toolbar, click the print icon . 

3. Proceed with your print job as you normally do. 

Method 3- 

1. Right-click anywhere in the frame that has the information you want to print.  

2. From the pop-up menu, select Print.  

3. Proceed with your print job as you normally do. 

  

How do I format my text (e.g. add bold, italics etc.)? 

Many areas of the Taskstream site allow subscribers to format their text using a built-in “HTML formatting toolbar”. 
This allows you to add formatting to text without the need to manually insert HTML tags: 

 Change the font style, font size, and font/background color. 

 Change the appearance of text characters with Bold, Italic, Underline, Strikeout, Subscript and 
Superscript

. 

 Format paragraphs with left, center, right or full justification. 

 Format numbered or bulleted lists, indent paragraphs or create block quotes. 

 Enhance text with inserted images, tables, links and special characters. 

The toolbar also includes buttons for cut, paste and other text-editing functions. For full details refer to 
the "HTML Toolbar" topic in the Appendix to the online Help. 

To enable the HTML Toolbar 

1. Go to the My Account Info area. 

2. Select your toolbar preference. 

3. Click the Enable link. 

Once enabled, this toolbar is available in most Taskstream tools where there are large text input areas. 
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What if I don't have the HTML Toolbar? 

Unless you access an area that employs the HTML Formatting Toolbar, there is no tool that allows you to format 
text.   

You can, however, manually insert the following HTML tags to change the format of your text to include italic, bold, 
and underline: 

Bold: <b>your text here<b> 

Italics: <i>your text here<i> 

Underline: <u>your text here<u> 

As shown above, these tags are used in pairs, inserted before and after the text you want to format. 

 Please feel free to explore other HTML tags and experiment! 

 

How do I add special characters to text areas? 

Symbols, also known as special characters, are defined as a character that is not alphabetic or numeric, such as 
punctuation marks (! ? ; ,), mathematical symbols (> < ≤ ≥), and indicators such as arrows and currency signs. 
Alphabetic characters with diacritical marks (á ñ ç) are also considered to be special characters.  

Taskstream supports two methods for entering the special characters that do not appear on your keyboard: 

When you have an HTML formatting toolbar available in your text area, as you do for many large text input areas 
in Taskstream, you can insert many commonly-used special characters directly from the toolbar. 

Using the special character icon of the formatting toolbar 

While entering your content in an input area, with your cursor in the spot where you need to include a 
special character: 

1. Go to the HTML Formatting Toolbar. 

2. Click the Special Character icon.  

 

3. The Select Special Character pop-up appears. 
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4. Locate the character you need to insert into your content area and hover your mouse pointer over 
your selection. 

 

 For easier use, when you hover over your selection:  

 A large representation of the character displays on the right-hand side of the window.  

 A description of the character is temporarily displayed as a tooltip. 

5. (Optional) To quit your action, click Cancel. The system navigates to the prior window. 

6. Click to select your character. The character appears at your last cursor position in the edit content 
area. 

You DO NOT need to have the HTML Formatting Toolbar enabled to use HTML tags to represent special 
characters. 

When you do not have the toolbar available, or if you want to insert a character that is not included in the toolbar 

set, you can manually enter the special character HTML tag. 
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Manually entering special character HTML tags 

While entering your content in an input area: 

1. (Only necessary if you have the toolbar enabled) Click the HTML icon (the first icon in the first row 

of the toolbar) to toggle to the Source View of the input area  

2. Enter the HTML tag for the special character you want to insert. 

 Begin each code with an ampersand (&) and a pound or hatch sign (#) 

 End each code with a semi-colon (;)  

Proper formatting of the code assures that the system correctly translates the codes as symbols. For 
example: 

Special Character HTML Code 

Greater than (>)  &#60; 

Less than (<)  &#62; 

Less than or equal (≤)  &#8804; 

Greater than or equal to (≥)  &#8805; 

Copyright (©) &#169; 

Click on this link to view an extensive list of Mathematical Operators and Relations HTML 

Codes 

2. To view the translation of the code, click Save Draft OR Save and Return or Apply Changes 
(depending on the field/screen in which you are working). 

 

The save returns you to the View mode, where the HTML code you entered displays as the proper 
mathematical symbol/special character. 

  

What is WebMarkerTM File Markup? 

The WebMarker ™ enables Evaluators to view uploaded file attachments without downloading the file or opening 
the software application typically used to view the attachments.  It also provides a way for Evaluators to add 
comments or markups directly to the work.  The comments are viewable by the Authors via PDF version of their 
work (their original document is also retained). 

  

http://www.w3.org/TR/1999/REC-html401-19991224/sgml/entities.html#iso-88591
http://www.w3.org/TR/1999/REC-html401-19991224/sgml/entities.html#iso-88591


  Taskstream Technical FAQs 

 

  T 1.800.311.5656       e help@taskstream.com 7 

 

The WebMarker ™ can be used to display and markup key file formats including but not limited to: 

Adobe Acrobat PDF 
Microsoft Excel 
Microsoft Word 
Microsoft RTF 

WordPerfect 
Plain Text 
JPEG 
TIFF 

BMP 
GIF 
Microsoft PowerPoint 

 

To learn about WebMarker ™ technical requirements, go to your online LAT Help. The "WebMarker" chapter 
appears in the Programs> DRF Programs> Evaluator section. 

WebMarkerTM is available for an extra fee. Please contact the Mentoring Services department at Taskstream at 

1-800-311-5656 for more information 

 

What is Turnitin® Originality Reporting? 

Turnitin's online OriginalityCheck product helps reduce incidents of unoriginal writing and improper citation by 
digitally comparing student work against an extensive pool of web pages, student papers, publications and library 
databases. 

Taskstream's integration with Turnitin® enables OriginalityCheck to be included as a preference when setting up a 
DRF Program. With this preference set,  work added to a DRF by the Author will trigger the generation of originality 
reports. The Author's work is processed by Turnitin® and a report is returned to the evaluator. 

In addition to the Turnitin® Originality Score, the full report includes a copy of the author's work with color-coded 

annotation to show incidents of potential plagiarism, unoriginal content and improper citation.  

Text comparison via Turnitin® reclaims hours of time that instructors and evaluators would otherwise spend in such 
analysis, while insuring the integrity of author submissions to a far greater degree. 

To learn more about using Turnitin®Originality Reporting with Taskstream, please contact the Mentoring 

Services department at Taskstream at 1-800-311-5656. 

 

Can I change the size of Taskstream text/fonts?  

The sizes of fonts in Taskstream reflect the font settings in your browser. The steps to follow to change font size 
vary based on the specific version of the browser you use. 

For help determining which browser version you use, click here. 

Reminder: when a larger scale font is used, fewer rows/columns of information will be visible on screen at 
a given time. 

Internet Explorer (IE) 

Starting from a session of Internet Explorer: 

1. Click View in the IE menu bar. 

2. Click on Text Size. An additional menu displays a list of relative font sizes (defaults to Medium). 

3. Click on the size you prefer. The screen immediately refreshes to display fonts scaled to this new size. 

  

mailto:help@taskstream.com
mailto:help@taskstream.com
mailto:help@taskstream.com
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Mozilla Firefox 

Starting from a session of Firefox: 

1. Go to Tools on the Mozilla Foxfire toolbar and click on Options 
 OR, (in later versions) go to the Firefox drop-down menu and select Options >Options. 

2. Click Content. 

3. In the Fonts & Colors area, use the pull-down menus to select a Default font and/or font Size. 

4. Click OK. 

Google Chrome 

Starting from a session of Chrome: 

1. Select Chrome Tools (wrench icon) on the browser toolbar. 

2. Use the Zoom tool to make your font incrementally larger (+ plus button) or smaller (- minus button) 

3. Click Exit. 

Apple Safari 

Starting from a session of Safari: 

1. Select View on the browser toolbar. 

2. Click Zoom In or Zoom Out until you reach the size you prefer 
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Troubleshooting 

When I click on a button nothing happens. 

Certain web browsers have software that regulates the creation of new windows within a website; this software is 

commonly referred to as pop-up blockers. If you are clicking on a button and nothing happens, it's more than 

likely that you have a pop-up blocker installed on your system.  

To allow pop-up windows from Taskstream, find out what type of pop-up blocker is installed, then follow the 
detailed instructions to allow pop-ups. 

Please keep in mind that your pop-up blocking software could be installed on your computer as a separate piece of 

software or as part of a security software package. 

 

Some of the features within the Taskstream site are missing. 

Due to an October 2011 security upgrade to Taskstream, some users of Internet Explorer (IE) will need to make a 
minor change to one of their browser Security settings in order to be compatible with the Taskstream site. 

If you are having trouble accessing certain areas of the Taskstream site (for example, the Folio or DRF areas), 
please follow these steps to make this adjustment: 

1. Start Internet Explorer. 

2. From the IE toolbar, click Tools. 

3. From the menu that displays, click Internet Options. 

4. From the pop-up Internet Options window that displays, click the Security tab. 

 

The pop-up window refreshes to show the Security page. 

The top portion of that page includes a set of Security Zone icons similar to these: 
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5. Click on the green checkmark icon to select Trusted Sites and click the Sites button to navigate to a 
screen with the related settings. 

6. Taskstream protects members' sensitive personal information by using HTTPS to transfer and display web 

content securely. To ensure that IT correctly acknowledges Taskstream as a secure, trusted site, it is 
necessary to remove any outdated listings from your IE settings. To update these settings: 

a. Read the listings in the Websites box to see if there are any current references to Taskstream. 

b. If you find any reference to Taskstream, click to highlight that listing and click Remove.  
For example: 

 

Note that https makes it unnecessary to manually list any Taskstream website as a trusted site, so if you 
see more than one Taskstream reference in this list, be sure to remove them ALL! 

7. Once the Taskstream listing no longer appears in the Websites box, click the Close button at the bottom of 
the window to save the Trusted sites information and return to the Security page. 

8. Click OK to close the Internet Options communications box and complete the settings process. 

 Reminder: Trusted sites are browser settings, not Taskstream preferences. If you use Internet Explorer, please 
check that all devices are updated with these settings. 

 

What if I've Removed the Trusted Sites that Refer to Taskstream and I'm Still Having 
Issues? 

While the above steps are usually sufficient to ensure compatibility, some users may need to manually add an 

updated Taskstream listing to the Trusted sites page. If you continue to have issues after removing the old listings:  

1. Repeat Steps #1 - 5 as described above, to navigate to the Trusted sites page. 

2. Add this website to the zone: 

a. Type this EXACT website address: https://*.taskstream.com 

b. Click Add. 

 

 You must enter these characters exactly as shown here or the listing will not take effect. 
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3. Once the new Taskstream listing appears in the Websites box, click the Close button at the bottom of the 
window to save the Trusted sites information and return to the Security page. 

4. Click OK to close the Internet Options communications box and complete the settings process. 

If you are still having issues, please contact the Mentoring Services department at Taskstream at 1-800-311-
5656 

 

When I try to download/view a file attachment, nothing happens. 

There can be a number of causes for this type of situation.  The most common cause is that your computer does 
not have the software application that created the file.  For example, if you download an attachment that was 
created in MS Word, you need a copy of this software application to be able to open the sample. 

Some software applications provide a trial or viewer version of the program that you can download from the Web 
and use to open the file that you downloaded from Taskstream.  For example, if you do not own Microsoft Word, 
you can download a Word Viewer from Microsoft that allows you to open and view Word files. 

 

I am not receiving emails from Taskstream. 

One reason why this could be happening is that your email program is interpreting incoming Taskstream mail as 

spam, which is a term for junk mail.  Spam is not typically stored in your Inbox, but rather in a folder specifically 

designed to hold unwanted mail. 

Try the following: 

1. Check your Junk E-mail folder for Taskstream-related emails. 

2. Examine your mail options and check for spam blocking software. 

3. (Optional) If possible, add Taskstream as an accepted source for emails. 

In the event that you have a Spam filter associated with your email account, please add the following to 

your address book (This ensures that Taskstream is recognized as an accepted site): 

 taskstream_subscriptions@taskstream.com 

 notification@taskstream.com 

 help@taskstream.com 

Even if Taskstream is recognized as an accepted site by your email client, you may have opted out of receiving 
automated Taskstream emails and/or Message Center forwarding. 

You can manage your Taskstream email subscription preferences in My Account. For details, refer to the 
"Email Subscriptions" topic in the My Account chapter of Help. 

 

I uploaded a file on my Mac, but the attached file does not open.  

This issue may occur if the document has been saved and then uploaded without the proper file extension.   

This is related to the way Mac operating systems handle files and file extensions. Extensions are the 3-4 characters 
that follow the "dot" at the end of a file name. The operating system uses extensions to identify compatible 
software that can open and read the file. For example, a file ending ".doc" is identified as a MS Word document, 
while ".ppt" identifies a PowerPoint presentation. 

  

mailto:help@taskstream.com
http://www.microsoft.com/downloads/details.aspx?FamilyID=3657ce88-7cfa-457a-9aec-f4f827f20cac&displaylang=en
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To remedy this situation: 

1. Remove the file from your work. 

2. Re-save your work, making certain to include the extension in the document path. 

 

My file is too large to upload.  

If your file is too large to upload, these optimizing file tips should help reduce the file size: 

Scanner 

When using a scanner, the scanning resolution determines the size of the scanned image.  Use a resolution of 72 
dots per inch (dpi) to get a life-size image when displayed on the screens of most computers.  Since computer 
screens display only about 72 pixels per inch, using a resolution higher than this will make your file size 
unnecessarily large. 

Software/Images 

 Save your original images separately 

 Use digital imaging software to crop unnecessary parts of the image. 

 Use .gif format when you do not need a lot of colors.  For example, simple line drawings, shapes, and small 

icons work well in this format.  You can optimize .gif images by reducing the number of colors.  The fewer 
colors you use, the smaller the file size.  Start with 256 colors, and reduce the number of colors until just 
before you notice a difference in the image.  

 Use .jpg format, when you are working with photographs.  When prompted, you can optimize .jpg images 

by using a lower quality choice.  The default save for a .jpg in most programs is set to 10, the highest 
quality.  You can try reducing it to a smaller number, depending on the necessity of a sharp image for your 
project.  The lower the quality, the smaller the file size.  Start with the maximum quality and reduce the 
image quality until just before you notice a difference in the image. 

 Reduce image size using a graphics-editing program (such as Adobe Photoshop, or Microsoft Photo 
Editor).  The smaller the dimensions of the image, the smaller the file size. 

PowerPoint 

 Cropping an image in PowerPoint WILL NOT reduce the file size. 

 When you resize the image in a program such as PowerPoint, you are only making the picture appear 
smaller on the screen - the actual file size of the image has not been reduced at all.  

 Individual images should be no larger than 200 kb, whenever possible.  Maximum size of all the images in 
the presentation should be no more than 4 MB, whenever possible.  

 Include a blank slide at the beginning of the presentation. It would seem as though adding a blank slide at 

the beginning of a presentation would increase file size; however, the opposite is true.  The blank slide 
serves as the preview image -- the image PowerPoint displays when you select a file in the Open dialog box. 
Since a blank slide is far less complex than the real first slide, the preview image is much smaller, thereby 
reducing the size of the presentation file. 
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Video 

In order to upload your video to Taskstream, you will need to compress it to a file size of 500 MB or less. 

Please note that, because video compression and manipulation occur outside of Taskstream, we are only able to 

provide limited support and do not endorse or support any specific video program. 

The following tips can help reduce file size with whichever video editing software you use  

 Change the resolution. 320x240 and 640x480 are common resolution settings for uploading video to the 
web. 

 Change the frame rate (number of frames per second).  Lowering the frame rate will reduce the size of 
the file. Please note this can reduce video quality if overused. 

 Change the audio quality.  Slightly reducing the quality of the audio track will help reduce file size.  

 You may also wish to separate your video into multiple sections. Each piece can then be uploaded to 

Taskstream separately and listed in chronological order by naming the files appropriately. It is possible to 
upload multiple video files to Taskstream as long as the total file storage space of your account is not 
exceeded and as long as each video file is 500 MB or smaller. However, please note that depending on the 
quality of your video, each section may still need additional compression to reduce it under the 500 MB 
limit. 

Additional information, too detailed to present here, is available from the Mentoring Services department at 
Taskstream (1-800-311-5656). 

 

Taskstream is reporting that I have entered unsafe text. What 
HTML formatting is "whitelisted" for safe use? 

Taskstream allows users to achieve advanced formatting and display effects by entering their own HTML formatted 
code in some areas of the tools. For example, you might use the HTML toolbar to emphasize text with bolding or 
italics or bullet lists. Any URL that you paste onto a Taskstream screen is also HTML coding 

The same HTML coding language that provides these benefits can potentially be used to inject malicious code into 
web pages. This may include JavaScript functions, form controls or artifacts that have been pasted from other web 
pages or word processing programs. Such HTML attack code would bypass security and display parameters 
normally imposed on web content, thereby gaining access privileges to sensitive page-content or session cookies, 
or changing the way Taskstream content appears in ways not approved by the company –or by you. 

By “whitelisting” only acceptable HTML code, Taskstream can continue to allow users to enjoy most of the 
formatting flexibility they currently enjoy while greatly reducing vulnerability to such cyber-attacks. 

The following markup is whitelisted for safe use in Taskstream products: 

HTML White List 

These whitelisted tags and attributes refer to longer areas of text that can render markup without display issues. 
This includes such Taskstream elements as the Main Text entered for a web page, or the text content added to the 
Text & Image area of a requirement on a template. 

  

mailto:help@taskstream.com
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Tags 

A, ABBR, ACRONYM, ADDRESS, AREA, B, BDO, BIG, BLOCKQUOTE, BR, CAPTION, CENTER, CITE, CODE, COL, 
COLGROUP, DD, DEL, DFN, DIR, DIV, DL, DT, EM, FONT, H1, H2, H3, H4, H5, H6, HR, I, IFRAME, IMG, INS, KBD, 
LI, MAP, MENU, OBJECT, OL, P, PARAM, PRE, Q, S, SAMP, SMALL, SPAN, STRIKE, STRONG, SUB, SUP, TABLE, 
TBODY, TD, TFOOT, TH, THEAD, TR, TT, U, UL, VAR 

These are primarily simple tags. Several more complex code tags are also whitelisted: 

 OBJECT and EMBED tags that attach Flash objects that include the Flash ClassID. 

To use the approved code shown below, replace the Bolded RED text with the values related to your Flash object.   
If you have printed this PDF to a black-&-white printer, note that this is the only bolded text in the code example. 

<object classid="clsid:d27cdb6e-ae6d-11cf-96b8-444553540000" 
codebase="http://fpdownload.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#version=8,
0,0,0" width="YOUR_WIDTH" height="YOUR_HEIGHT"> 
 
<param name="movie" value="HTTP://WWW.MY_WEBSITE.COM/MY_FLASH_MOVIE.SWF" 
/> 
        <embed src="HTTP://WWW.MY_WEBSITE.COM/MY_FLASH_MOVIE.SWF" 
width="YOUR_WIDTH" height="YOUR_HEIGHT" type="application/x-shockwave-flash" 
pluginspage="http://www.macromedia.com/go/getflashplayer" /> 
 
</object> 

 iFrames added to the DRF Program submissions and Folios/Web page content 

For shorter text areas and certain other input areas, only a sub-set of Tags (indicated above by underlined 
text) is available. 

Attributes 

abbr, align, alt, archive, axis, background, bgcolor, border, cellpadding, cellspacing, char, charoff, charset, classid, 
clear, codebase, color, cols, colspan, compact, content, coords, data, datetime, dir, face, for, frame, frameborder, 
headers, height, href, hreflang, hspace, http-equiv, ismap, label, lang, language, link, longdesc, marginheight, 
marginwidth, media, name, nohref, noresize, noshade, nowrap, pluginspage, quality, readonly, rows, rowspan, 
rules, scheme, scope, scrolling, selected, shape, size, span, src, standby, start, style, summary, tabindex, 
target="_blank", text, title, type, usemap, valign, value, valuetype, version, vlink, vspace, width, xml:lang 

For shorter text areas and certain other input areas, only a sub-set of Attributes (indicated above by underlined 

text) is available. 

Style Attributes 

The attributes listed here are grouped as they would appear in a standard cascading style sheet (css): 

background, background-attachment, background-color, background-image, background-position, background-
repeat, background-clip, background-origin, background-size  

border, border-bottom, border-bottom-color, border-bottom-style, border-bottom-width, border-color, border-left, 
border-left-color, border-left-style, border-left-width, border-right, border-right-color, border-right-style, border-
right-width, border-style, border-top, border-top-color, border-top-style, border-top-width, border-width, outline, 
outline-color, outline-style, outline-width, border-bottom-left-radius, border-bottom-right-radius, border-image, 
border-image-outset, border-image-repeat, border-image-slice, border-image-source, border-image-width, border-
radius, border-top-left-radius, border-top-right-radius, box-decoration-break, box-shadow  

overflow-x, overflow-y, overflow-style, rotation, rotation-point  

color-profile, opacityrendering-intent  
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height, max-height, max-width, min-height, min-width, width  

box-align, box-direction, box-flex, box-flex-group, box-lines, box-ordinal-group, box-orient, box-pack  

font, font-family, font-size, font-style, font-variant, font-weight, @font-face, font-size-adjust, font-stretch, quotes  

grid-columns, grid-rows  

target, target-name, target-new, target-position  

list-style, list-style-image, list-style-position, list-style-type  

margin, margin-bottom, margin-left, margin-right, margin-top  

column-count, column-fill, column-gap, column-rule, column-rule-color, column-rule-style, column-rule-width, 
column-span, column-width, columns  

padding, padding-bottom, padding-left, padding-right, padding-top  

page-break-after, page-break-before, page-break-inside, border-collapse, border-spacing, caption-side, empty-
cells, table-layout  

color, direction, letter-spacing, line-height, text-align, text-decoration, text-indent, text-transform, vertical-align, 
white-space, word-spacing, hanging-punctuation, punctuation-trim, text-justify, text-outline, text-overflow, text-
shadow, text-wrap, word-break, word-wrap  

appearance  

 

My Taskstream graphs are empty 

If your Taskstream graphs are empty, you are probably using Internet Explorer (IE). Graphs in reports rely on 
background colors, which IE does not print by default. 

To enable background color printing in IE 

1. Start from a session of IE (you do not need to be logged into Taskstream) 

2. Click File in the IE menu bar 

3. Select Print Preview 

4. From the Print Preview toolbar, select Settings OR Page Setup OR the gear icon (depending on your 
version of IE) 

5. Check the Print Background Colors and Images box 

6. Click OK to save the setting 

 


